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e.World Technology Limited
Tutorial on DVD Album Creator

1. INTRODUCTION

In this tutorial, we will illustrate, step-by-step, how to create a DVD with introductory video,
subtitles, pan and zoom, and closing credits.

The generated DVD should be the same as the one generated by 'Demo project (with subtitles)'
which can be downloaded at http://www.hketech.com/dvdac/download.php.
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2.

2.1

2.2

CREATE SLIDESHOWS

Preparation

First of all, install DVD Album Creator, and then launch DVD Album Creator. DVD Album
Creator can be launched by:

e Double click the DVD Album Creator icon from the Windows Desktop, or
e Click 'Start' -> 'All Programs' -> 'DVD Album Creator' program group -> 'DVD Album
Creator' icon

The pictures used in this illustration can be downloaded at
http://www.hketech.com/dvdac/download.php (Demo project with subtitles). Please follow the
instructions in the readme.txt to unzip the pictures to the folder 'C:\DVDAC'".

Add First Slideshow

In the file pane, navigate to the folder 'C:\DVDAC":

€& DVYD Album Creator - Proj

File Help
J j Photos & Audios
Files -
Recent folders =
+-{ 7 dell .
+-{ = Documents and S
+-{{=) DRIVERS
_;I Dv'Dac
-7 386
+-{ Inetpub
Qe @
£ >
4 W =a
Mame Size | -
%] Blank1.png ZKE |
.i_':l IMG_0001, JPG 200 KE
ﬁ_‘:] IMG_0002, PG 169 KE
|i_‘:| IMG_0003. PG 166 KE
|i_':| IMG_0004, PG 172KE
ﬁ_‘-] IMG_000s, JPG 119KE

The available images will be shown below the file pane. Drag and drop the pictures
IMG_0001.JPG to IMG_0005.JPG to the photo pane:
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[=]=]
4+ & 88
Marme Size | 1 %
| Elanki.png ZKE F
[ ima_ooo1.JPG 200K
163KE
[ 1me_nooz. PG 166 KE
1r1u.J_|_u_u_|4.JFu.J E3: I —
1 _noos. rG 119KE

A add slideshow %)) Add

Slideshowal
You have already created the first slideshow with pictures!

Then press function key 'F2' to rename the slideshow to 'Subtitle Demo":

Slideshiows

W add slideshow %)) Add titles

Subtitle Demol

The slideshow name 'Subtitle Demo' will then be shown in the DVD menu created during
compilation.
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3. CUSTOMIZE FIRST SLIDESHOW

3.1 Set Slideshow Global Options

Click 'Reset photo options' button at the toolbar:

tﬂ Photos | J‘ Audins
#] % % s a 2 B3 | "

Reset phoko options

IMG_0001,IPG IMiG_000z2, IPG IMG_0003, PG

The following screen will be shown:

]

Reset Photo Options

[ v Feset phato duration 3 = ]
T ranzition Effect
[ v| Rezet transition effect Fade indout - ]
Reset effect duration 2 =
Pan & Zoom
Feszet pan & zoom effect | Mone -
Reszet pan & zoom ratio o =

Apply above zettings to;

() Selected photos in the current slideshow only
( () &ll phatos in the curent slideshow j

() &ll photos in thiz project (&l existing sideshows]

[ | iSet above setings as project default [for new shdeshows] ]

k. ﬂ Cancel |

Amend the options as illustrated in the figure:

e Reset photo duration to 3 seconds
e Reset transition effect to 'fade in/out’
e Select 'All photos in the current slideshow'
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e  Check the box 'Set above settings as project default (for new slideshows)
As a result, all existing pictures and pictures added later to this demonstration project will use the

new settings.

3.2 Customize Individual Picture

Toggle to 'details view' by clicking the 'Details view' button in the toolbar:

L’ﬂ Photos | J‘ Audios
i] b 4 ?J it 2k =l E

=]

0

B

Details view |_

Customize the transition effect of:

e IMG 0002.JPG from 'Default' to 'Unroll (from left)'
e IMG 0003.JPG from 'Default' to 'Pixelate’

Customize the Pan and zoom effect of:

IMG_0001.JPG to 'Zoom in (center)'
IMG_0002.JPG to 'Pan left to right'
IMG_0003.JPG to 'Pan top left to bottom right'
IMG_0004.JPG to 'Zoom out (top left)'

The resulting screen will look like:

File Dake/Time | Duration | Effect EFfect duration | Pan & Zoom EFfect | Pan & Zoom Ratia...
CADVDACLIMG_0001. PG 4/ 13/2008 1 3 Fade injout 2| Zoom in (center) ]
CADVDACLIMG_0002.JPG 4 13/2006 1 3 Unwoll (From left 2 Pan left to right {m 0
CADVDACIIMG_0003.JPG 4)13/2006 1 3 Pixelate Z Pan bop left bo bott 20

B C\DVDACYIMG_0004.006 |4/13/2006 1] 3|Fadeinjost | 2om out (top left)
CADVDACKIMG_0005.3PG 4/13/2008 1 3 Fade injowt 2 Default 2
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4.1

CUSTOMIZE DVD MENU

DVD Album Creator will automatically compile DVD menus for audience to choose the playback
slideshow as well as how the playback should be (e.g. non-stop repeat playback of all slideshows).
In this demonstration, first we modify the color of the buttons in the menu:

B ackground & Calars
Background image =
Background color | Black | 121
Button zelection colar fqua w | 35 Button activation color [ Darkires v | 53)

Then we instruct DVD Album Creator to create the 'Repeat Play' button on the slideshow menu.
This button allows audience to play a specific slideshow repeatedly.

Menu & Text Options b1y

tenu Text
| wenu ]

Foak menu

[ v iCreate 'Repeat Play' I:uuttu:unEJ

You may note that the selection of 'Main menu' is disabled. This is because we have only 1
selectable slideshow (introductory video is a compulsory slideshow, and play once after the DVD
is inserted). If there is more than 1 selectable slideshow, a main menu will be compiled
automatically, and you can optionally choose to place the 'Play All' button and/or 'Repeat Play All'
button in this top level menu. You may also try our 'Demo project (without subtitle)' in our website
to view the output. In that demonstration project, 8 selectable slideshows are compiled within 1
DVD.

Text Appearance
You may also notice that there is a tag called '"Text' in the panel:

Merw & Text Options L

| b eru Text
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Click this tag will show the options available for customizing the appearance of the text in the
DVD menu. In this demonstration project, we use the system default values to compile the DVD
menu.

4.2 Preview DVD Menu

To preview the DVD selection menus, you may click the tag 'Root Menu' beneath the preview
window:

Subtitle Demo

Chapters Repeat Play

Main menu | Roak rmenu N Chapker menu

You may also click the tag 'Chapter menu' to view the scene selection menu. This menu will be
shown if the audience presses the 'Chapters' button in the 'Root menu'.

If there is more than 1 selectable slideshow, the tag 'Main menu' will show the layout of the top
level menu for preview.
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5.

5.1

5.2

ADD SUBTITLES 1

In this section, we will illustrate, step-by-step, how to add subtitles to DVD using Exif data and
your own narratives. In next section, we will illustrate how we can add subtitles to each picture
using your own narratives.

Set Up Properties of Different Subtitles Streams

First of all, invoke the subtitles menu by choosing 'Options' -> 'Subtitles":

o5 & Audios £ 4 Cpkions @ Cutput

Menu Transition Effect Fan & Zoom subtitle -, |
s

DVD Album Creator supports at most 8 streams of subtitles. Audience can use the subtitles button
in the DVD player remote unit to select the desired subtitles stream.

In our demonstration project, we compile the DVD with 4 subtitles streams.

Stream
Number Content Our Usage Color

1 Custom Subtitle Display picture information Yellow

2 Custom Subtitle Our narratives White

3 Filename (without extension) | Filename Silver

4 Exif date and time Show picture taken date and time | Gray

Conkent Color

Subkitle 1 Custom Subtitle v Vellow | 33
Subtitle 2 Custom Subtitle - White | 22
Subtitle 3 [File_NamewithoutE xtension] hd Sitver w32
SUI:lt":IE 4 \one - - Gra':." - ";)l

; Mone -
Subtitle 5 i s
HERE Custarn Subtitle white v | 33
Subtitle & [Slideshow_Mame] . =
HoHHE [File_MarnetithExtension] white w | 3

; File_MarmewithoutExtension
subtitle 7 |[Flle_flam ] whits w| 3
Subtitle & i iy
HOHHE [EXIF_IrmageDescripkion] w7 white w | 2
Default subtitle |1 -

The 'Default subtitle' controls which subtitle stream to be displayed once the slideshow is played.
We keep the default to display subtitle 1.

Customize Subtitle 1

Our next step is to customize our subtitle 1 for all pictures in the slideshow. In this section, we
demonstrate how to use the 'Custom subtitles' and 'Subtitles editor' to set up the subtitles.
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Now we go back to the 'Photos & Audios' panel, right click the first picture and select 'Custom
subtitles'. Alternatively, you may click the 'Custom subtitles' button =| on the toolbar as

highlighted in the below figure:

kﬁ Photos | J Audins
1% % EEMEEIRS

%] add blank slide

= # Remove photo -
IME_0001, I d* Rotake left D003,
#k Rotate right:

Blcooniies

E Reset phoko options

51 Photo properties
| v |Set as slideshow thumbnail

Then the Custom Subtitles panel will be shown. We check the 'Update’ box for subtitle 1, and click
the '..." button at the end of the line to invoke the subtitle editor:

Custom Subtitles

MNote: To use custom subtitle, set the subtitle as "Custom Subtitle® in Options->Subtitles page First.
Apply sbove sattings bo:

(%) Selected photos in the current slideshow only
{3 &l photos in the current shdesho
() All photos in this project (All existing shdeshows)

| OK I Cancel |

In the subtitle editor will be shown. Drag and drop [EXIF ExiflmageWidth],
[EXIF_ExiflmageHeight] and [EXIF ApertureValue] from the left panel, and put the wordings ' x'

and '; Aperture' between the tags:
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& Subtitle Editor

[EXIF_ExilmageWidth] x [EXIF_ExfImageHeight]; Aperture

%

EEX

Enter your sublithe in the editor on the right pane. Max, 255 chars. You can drag predefined variables from the kst on the left.

Cancel

Click 'OK' button to close the form. Then we will return to the Custom Subtitles panel.

Apply this setting to subtitle 1 of all photos in the 'Subtitles Demo' slideshow by clicking 'All
photos in the current slideshow'. Then click 'OK' to quit the Custom Subtitles panel.

Mote: To use custom subtitle, set the subtitle as ‘Custom Subtitle' in Options- =Subtitles page first

Apply above setkings to:

() Selected photos in the current slideshow anly

(#3:all phokos in the current slideshow

) all phokos in this project (Al existing sideshows)

84

Cance

This will set up subtitles 1 for all pictures in the slideshow 'Subtitles Demo'.

-10 -
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6.1

ADD SUBTITLE 2

In this section, we will illustrate, step-by-step, how to add your own narratives to the subtitles of

each picture, that is, subtitle 2 in our demonstration project.

Add Subtitle 2

Double click the first picture in the 'Photos & Audios' pane. The 'Photo Properties' should be shown.
Click 'Subtitle 2' input box which is beneath the preview window, and enter "This is demo picture 1':

Photo Properties - IMG_0001.JPG X
Options s

Fhoto duration
S
Transition effect
Dt aulk ﬂ
Effect Duration
i3
Pan & Zoom effect
[Zooen in {center ﬂ

Pan & Zoom ratio (%)
20 3]

Custom Subtithes (Mote: To use custom sublitle, set the subtitle as 'Custom Subtitle' in Options-=Subtitles page first.) &
v Preview subtitle
Subtitle | [EXIF_ExiFimageWidth] x [EXIF_ExiflmageHsight]; Aperture

Siibtiths 2 WThiz = dema picburs | e

CADVDAC|IMG_0001.0PG Photo 1 of 5

EEEE &

To navigate to the next picture, press the 'Next' button near the lower left corner:

| s o [ 1N L=

C:\DYDACIMG_D001.IPG

(<L<[-])

Then the next picture, together with its properties, should be shown on the panel. We can then enter
our narratives for the second picture. We can repeat pressing the 'Next' button and enter our

“11 -
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narratives, until all our narratives have been entered to the designated picture. The narratives used
in our demonstration project are:

Picture Subtitles

IMG 0001 This is demo picture 1

IMG 0002 This is demo picture 2

IMG 0003 This is demo picture 3

IMG 0004 This is demo picture 4

IMG 0005 This is the last demo picture

6.2 Preview Subtitles

In 'Photo Properties', you may click different subtitle number (e.g. subtitle 4) to view the subtitles
in the preview windows. You may also press the 'Back to Beginning' button and then the 'Play’
button to preview the video playback:

CHDVDACIMG_0005. IPG Photo 5 of 5

=] ]

The playback will show all visual effects selected for the pictures, for example, subtitles, pan and
zoom, transition effect, etc.

Press 'Close' button near the lower right corner to close the 'Photo Properties' panel. This will bring
us back to the 'Photos & Audios' panel.

_12-
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7. ADD CLOSING TITLES

DVD Album Creator provides handy ways to incorporate titles sequence, beginning credits and
closing credits to your slideshow. In this section, we will illustrate how to add closing credits to our
'Subtitles Demo' slideshow.

7.1 Add Closing Credits

First, click the 'Add titles and credits' button on the Slideshows toolbar:

Slideshows
7 add slideshow || Add titles and credlts ¥ « »
ﬁ .ﬁ.dd kitles and credlts|
Slideshiowm1 Subtltle Demo

The 'Titles and Credits' panel will be shown.

7.2  Titles and Credits - First Set

We add our first Titles line by clicking the 'Insert' button on the Titles toolbar:

J Titles and Credits | Options

Titlez

+ ﬁ- v X 4 e
Insert

Then we overtype the content by 'CRAFT":

J Titles and Credits Cpkians

Titles

b = v X 4 A = »
CRAFTS|

We then click the 'Insert' button on the Credits toolbar, and overtype 'Left' and 'Right' columns
using 'Camera’ and 'e.World Technology Limited' respectively:

Creditz

== W M 4 A ek

Left Trsert Right
Camera e Wiarld Technalogy Limite:

~13 -
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Tips: You can use the 'Tab' key to tab between 'Left' and 'Right' columns.

By pressing the 'Insert' button and entering the contents, we altogether inserted the following 4
Credits lines to the current Titles:

Credits
e = M A » M &
Left Riight _ _
Camera e orld Technology Limited
Dezign 0D Alburn Creatar Suppart
Lightinig M atural Sunlight
Arirmation D Album Creatol

We have completed adding the first set of Titles and its associated Credits.

7.3  Titles and Credits - Second Set

We will continue to add our second set of Titles and Credits. Press 'Insert' button at the Titles
toolbar, and perform similar action to add the below Titles and Credits:

Line Type Contents

Titles PRODUCTION

Credit Line 1 (Left) Directed by

Credit Line 1 (Right) DVD Album Creator Support
Credit Line 2 (Left) Produced by

Credit Line 2 (Right) DVD Album Creator

Credit Line 3 (Left) Production Team

Credit Line 3 (Right) e.World Technology Limited

The resulting screen will be similar to the below one:

J Titles and Credits | Cpkians

Titles

- 4 A » B i
CRAFTS

FPRODUCTIOMN

Credits

+ - 4 A = B i

Left Right

Directed by DD Alburn Creatar Suppart
Froduced by DD Alburn Creator

Froduction Team etw'orld Technology Limited

7.4 Title and Credits - Last Set

We click the 'Insert' button again to add the last set of Titles and Credits. We click the '..." button at
the end of the line to type multiple lines for this set of Titles:

- 14 -
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Titles

= = v X 4 A B+ B ir
|CRAFTS
PRODUCTION

Title 1

Then an input panel will be displayed for us to input lines of titles. Enter the following lines:

Copyright 2006
e.World Technology Limited
All rights reserved

The screen will look like:

& Title [=E3

Copywright 2006
&.Waorld Technology Limiked
All rights reservecﬁ

Close |

Press the 'Close' button at the lower right corner to update the Titles line. This set contains Titles
only, and there is no need to insert any Credits line.

Now we have entered all desired Titles and Credits. We move on to next section to customize the
appearance and display theme for them.

-15-
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8.

8.1

CUSTOMIZE AND PREVIEW CLOSING TITLES

We have added 3 sets of Titles and Credits in the previous section. Without customizing the
appearance, the layout of the Titles and Credits may not be satisfactory. Take the last set of Titles
as example. The preview screen located at the upper right corner will show:

Presview [Duration: 00:00:30]

13 Fade infout, ohe page per title or credit, = -

Copyright 2006
e.World Technology

Limited
All rights reserved

In this section, we illustrate how to customize the closing credits. Our target is to turn the
appearance of the closing credits to:

Presiew [Duration: 00:00:14]

13 Scroll, single page, side-by-zide -

F N

Background Image

We click the 'Options' tag in the 'Titles and Credits' panel. Then we will toggle to the option page.
First we would add a background to our titles using the last picture in the slideshow. We press the

‘Browse' button 7 at the end of the 'Background image' input box, and select
'C:\DVDAC\IMG_0005.JPG":

- 16 -
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Titles and Credits | Options |

Background image  \C:\DVDACYMG_000S. PG Fade in

Select 'Fade out' so that DVD Album Creator will fade out the closing credits.

8.2  Customizing the Appearance of the Titles and Credits

We will change the font settings to:

Line Type Color Height | Bold? | Alignment

Titles White (default) 23 Y Center (default)
Credits (Left) Yellow 20 Y Right justified
Credits (Right) | White (default) 15 Y Left justified (default)

The resulting screen will look like:

Fonk Color Height (pixels) Transparency t‘:&-}_
w0 2] [[B]|2
1005 I

100 3] |[B|Z

Titles T Arial - White w | 22
=
Credits (Left) | T Arial - Yellor w | 25|
R -

Credits (Right) | B Arial - Whike w | 25}

"
il [ﬁ’] %

=]
W
[}

8.3 Playback Theme

DVD Album Creator provides different themes to display the Titles and Credits. In our
demonstration, we select the style 'Scroll, single page, side-by-side":

Skyle Fade injout, one page per title or credit, stacked -
Fade infout, single page, stacked
Duration per pafFade infout, single page, side-by-side ically)

Fade infout, one page per title ar credit, stacked
Margin (%) Fade infouk, one page per title or credit, side-by-side
Fade infout, one page per set of title and credit, stacked
Fade infouk, one page per set of title and credit, side-by-side
Add titles and c|Scrall, single page, stacked

E'_:n:r'El"., single page, side-by-side

{+ beqinning o

Typewriter (kitles only)

8.4 Make these Closing Credits

We would make these the closing credits by selecting 'end of preceding slideshow' under 'Add titles
and credits to'. This appends the Titles and Credits to the end of preceding slideshow (which is the
'Subtitle Demo' slideshow in this demonstration):

Add titles and credits ko

(" beqginning of following slideshow

{» &nd of preceding slideshuwl%

-17 -
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Preview the Closing Credits
To preview the closing credits, click the 'Titles and Credits' tag to return to the Titles and Credits

8.5
input panel. Preview window is located at the top right corner. Press the 'Play' button * to start
previewing the closing credits:

Presiew [Duration: 00:00:14]

Scroll, single page, side-by-zide
You may also try modifying the display style and preview the effect in the preview window.

Press 'Close' button near the lower right corner to close the Titles and Credits panel.

218 -
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9.1

9.2

9.3

ADD INTRODUCTORY VIDEO

At this point, we can output a DVD slideshow with subtitles, chapter menu and closing credits.
However, we would like to add some more.

In this section, we would like to incorporate a welcome page to the DVD. This welcome page will
be unconditionally and automatically played once, after the DVD is inserted into the player. This
resembles the copyright or FBI warning screen displayed in commercial DVDs.

In DVD Album Creator, we call this 'Introductory Video'.

Add Introductory Slideshow
Click 'Add slideshow' button at the Slideshows toolbar to append a new slideshow:

Slideshiows

@, Add slideshow '4}'=|| Add titles and credits

add slideshiow

Subtitle Demo Title1

Add Pictures to the Slideshow

Since the welcome page contains text only, we add a dummy picture to the slideshow. Thus, click
the 'Add blank slide' button to append a blank slide:

Lﬂ Phiotos | J 1}
. B 0 A
Add blank, slide

Accept using the default color, which should be black. A blank slide should be added.

Toggle to 'details view' by clicking the 'Details view' button in the toolbar. Then change the display
duration of the blank slide to 1 second:

L’ﬂ Phiotos | J‘ Audios

il P e + & @ & B8
File DratefTime | Duration | EFfect EFfect
il i . \Project1Blankl . png

Mark Slideshow as Introductory Video

Set the slideshow as introductory video by right click the Slideshowl icon and select 'Set as
introductory video":
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9.4

9.5

Slideshows - Slideshow! (Yideo: 00:00:01, Audio: 00:00:00)

At dd slideshow ﬂ Add titles and credits  « »

Add slideshow

Delete

Renarme

Mt Sl L Sef as introduckory video

This will cause Slideshow! to be played once and only once automatically right after the DVD is
placed in the DVD player.

Add Welcome Page using Beginning Titles and Credits

Similar to the previous slideshow, we click the 'Add titles and credits' button on the Slideshows
toolbar to add a new set of Titles and Credits:

Slideshows
2 add slideshow ﬂ Add titles and credits X &« »
[%.ﬁ.dd kitles and n:redits|
4]
Subtitle Demo Title1

The 'Titles and Credits' panel will be shown.

Create Welcome Page

We click the 'Insert' button at the Titles toolbar to add the Titles. We click the '..." button at the end
of the line to enter multiple lines for this set of Titles:

Titles

d = v X - 4+ H

o

An input panel will be displayed for us to input lines of titles. Overtype the default text 'Title 1'
with the following lines:

You have successfully compiled the demonstration project using DVD Album Creator.

We hope you have had a pleasant experience with DVD Album Creator.

The screen will look like:
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9.6

9.7

8 Title

You have successFully compiled the demonstration project using DWD Album Creator,

We hope vou have had a pleasant experience with DVD album Creator,

Close |

Press the 'Close' button at the lower right corner to update the Titles line. Then press the 'Insert’
button at Credits toolbar and enter 'e. World Technology Limited' in the 'Left' column:

Creditz
EE— 4 4 > »
Left Right

e \world Technaology Limite:

Customize Appearance of the Welcome Page

Similar to 'Subtitle Demo' slideshow, we customize the appearance of the welcome page via the
'Options' in 'Titles and Credits'. Click the 'Options' tag and make the below customization:

Titles: Violet, 15 pixels, bold and left justified
Credits (Left): Yellow, 15 pixels, bold

Style: Fade in/out, single page, stacked
Duration per page: 6 seconds

The resulting screen will look like:

Fork Transparency (%)

Tithes B Arial vl Violst w | 22) 100-=] g_ =
Credis (Left) | T avial v vellow v | 5 w | |[Blir U|El==
Credits (Right) | Ty Arial - white v | 302 ws: B I UEES
Style LFade infout, single page, stacked J -

Drakion per page (seconds) | 65 || (Nobe: if 0, duration is assigned aukomaticalby)

Margin (%) o7

Add titles and credits to:

(* heginning of Following shdeshow
(" end of preceding slideshow

Preview the Welcome Page

Click 'Titles and Credits' tag to go back to the input panel. We can preview the layout of the
welcome page in the preview window, and it should look like:
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Presiew [Duration: 00:00:08]

13 Fade infout, single page, stacked -

& World Technology Lim|ied

You may change the background color (e.g. blue) of the welcome page simply change the
background color in the 'Options' panel. For simplicity, we use the default background color, that is,
black, in this demonstration.

Click the 'Close' button near the lower right corner to close the Titles and Credits panel.

9.8  Associate the Titles and Credits with the Introductory Video
Now the slideshows panel should look like:

Slideshiows

7 add slideshow '4]’__ Add titles and credits |7 3 @ 9
a

Subtitle Dema Title1 Slideshowl

As 'Title2' will be played before the preceding slideshow, we need to re-order it before our
introductory video 'Slideshow1'. Simply press the 'Move up' button on the Slideshows toolbar to
move Titles left by 1 position. The resulting screen will look like:

Slideshows

77 add slideshow '4}'__ Add titles and credits |7 3

s

=
|

Subtitle Demo Title1 Slideshiowl
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9.9 Optional - Move Introductory Video to the Beginning

If a slideshow is marked as Introductory Video, DVD Album Creator will ensure that it will be
played first, even its position in Slideshows panel is beyond other slideshow(s).

If you would like to arrange the slideshow icons in playback sequence, you may move the 'Titles'
and 'Slideshow1' up to the front by selecting the respective icon and click the 'Move up' button.
Then the Slideshows panel will look like:

Slideshows
57 add slideshow 'EJ Add titles and credits X &« »
[ +] 4]
Titlez Title1

We have now completed incorporating a welcome page to the DVD using Introductory Video. We
will move on to compile the DVD.
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10.

10.1

10.2

10.3

PROJECT FILE AND OUTPUT

Output Setting

We have now reached the final step to output our video. Click 'Output' tag at the main screen to
switch to the Output panel.

In the Output panel, we change the volume label to 'DVD DEMO' and destination folder to
'C:\DVDAC":

[‘-.-'-::Iume label  |DvD DEMO ]

-

Copies 12 Erase disc before burning

archive phokos to disc

[Destinatiun folder |C:\DvDAC = ]

Please note that the volume label will be dimmed if there is no DVD burner installed in your
computer.

If you have software DVD player and would like to view the demonstration project in the computer
instead of burning it into a physical DVD, you may uncheck the option 'Record to disc' near the top
of the panel. The output DVD system will be stored in the destination folder (C:\DVDAC in our
example).

Project File

Before outputting the video, you may save all the works you have done to a 'Project file' for later
retrieval. Select 'File' -> 'Save As' in the main toolbar:

. DVD Album Creator -

Mew
Qpen...

Save

Preferences. ..

Choose the location and filename, and then press 'Save' button to save a project file. Afterwards,
you may open the project file in DVD Album Creator (or simply double click the project file in
Windows Explorer) to re-open the project.

Output the Video

o ]
Click the 'Output' button to instruct DVD Album Creator to compile the video. Wait

for a moment and the DVD video will be written to your destination folder and/or DVD.
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This tutorial demonstrates part, but not all, of the features of DVD Album Creator. The user
manual documented our features in details. You may also try compiling some more videos and
explore the convenience and flexibility that DVD Album Creator brings to you.

- The End -
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